
Microlearning Lesson Plan 
Creating a template in PowerPoint and importing it to Storyline 360 

Melanie Isola and Meredith Sward 
 

Completed as an Instructional Design Team to bring a cohesive voice to these units.  
Learner Outcome 
 
 
 
 

Adult learners will successfully create a learning 
experience template with a custom background, fonts, and 
buttons and import the PowerPoint file into Storyline 360. 
GOAL: After completing these units, participants will be 
able to create a more visually appealing, interactive 
learning object to better engage with their future learners.  

Task  Lesson 1 focuses on the creative process of cohesive 
design fundamentals using constructivist principles.   
Lesson 2 focuses on executing the proper structural setup 
using behaviorist principles.  
As a group, these two units help remind the participant of 
the importance of properly setting the stage for their 
learning object.  

Learner Analysis  Adult learners who have familiarity with PowerPoint and 
are learning Storyline 360. These learners have 
fundamental knowledge of the elements of design. 

● 25 - 55 years old 
● Working professionals who are new to eLearning 

software, like Articulate Storyline 
● Basic understanding of PowerPoint + Storyline 360 
● Basic understanding of the principles of design 

Required Technology Computer, PowerPoint, Storyline 360, Internet 
Duration Lesson 1: 20 minutes 

Lesson 2: 8 minutes 
Final Assessment: 20 minutes 
Overall the entire course is less than 60 minutes.  

Objectives Lesson 1: Create an engaging custom template in 
Powerpoint  

1.  Decide on a background image that reflects your 
project and insert it in PowerPoint. 

2. Select one to two fonts and three font sizes for the 
heading, subheading, and body text. The font 
should be legible.  

3. Use the shape tab to insert a shape style for your 
navigation buttons and change the color to match 
your template theme.  



Lesson 2: Properly upload that custom template into 
Storyline 360 

1. Set your aspect ratios prior to uploading your 
template 

2. Set and lock your template background after your 
upload is complete 

3. Turn off default navigation buttons to ensure there 
is no cognitive overload  

Standard To pass these courses, the learner is required to achieve 
an 80% on any given unit or final assessment, or the 
course needs to be repeated for certification. 

Prior Required Learning Lesson 1: Create an engaging custom template in 
Powerpoint  
The participant has a basic understanding of the principles 
of design. They have reviewed the following videos on 
design: Fundamentals, Color, Typography, and 
Layout/Composition. This unit is to apply this past training 
on design to ensure a new learning object is properly 
created.  
Lesson 2: Upload that custom template into Storyline 360 
The participant has already viewed the LinkedIn Learning 
course on Storyline 360 Essential Training. This unit is to 
support post-learning and ensure the participants are able 
to successfully get their learning object started.  
 

Condition These participants are able to utilize the presented units 
on their own time, during a normal work week.  
These units would ideally be presented to a group of 
individuals who are working in training and development 
and are new to eLearning platforms, like Storyline. They 
are taking their training to the next level.  
Completing these two units and the given assessment 
would end in an internal certification for the participants.  

Delivery Interactive video, such as edPuzzle. This is an 
asynchronous microlearning object. The two lessons can 
be taken immediately back to back, or over time. The final 
assessment can be completed immediately after lesson 2, 
or within a week of course completion.  

UDL in Practice The videos will have closed captioning, speed controls, and 
prompt learners with questions.  

Instructor Introduction Melanie and Meredith. We recently worked together to 
create a template in PowerPoint for use in storyline 360. 



They will teach you how to work between PowerPoint and 
storyline to create a custom template.  

Lesson 1 completed by Meredith Sward 
Instructional Outline - Lesson 1 
 
Learning Strategies: Direct Instruction 
+ Decision Making  
Learning Theory: Cognitivism 
 

  

First learning Point: Adding a 
background image 

On-Screen action: From the (1) Design Tab > (2) Format 
Background (background image properties open on the 
right-hand side of the screen)>  (3) picture or texture > (4) 
insert > (5) select image from your project files 
 

 
 

 
 
Question Prompt:  What is your learning project about? 
What colors or images reflect the theme of your project? 
  
Narration: “My project is on first-aid situations that can 
happen at Summer Camp. I chose to use an illustration of 
a camp map.” 
  



Question Prompt/Narration: Did you use an image? Is it a 
busy image like the camp map I used? I will adjust the 
transparency of my background image to make the text 
easier to read. 
 
On-Screen Action: (1) Design tab > (2) Format Background 
> (3) picture or texture > (4) transparency > (5)  apply to all 

  
Reflection: What message are you trying to convey 
through your design decisions? 
 

Second Learning Point: Choose font 
family and sizes 

On-screen: (1) Insert> (2) Text Box > (3) Draw text box  
 

 
On-screen: (1) Type text in text box > (2)Home tab > (3) 
change font family > (4) change font size 
 



 
  
Repeat for sub-heading and body text 
 
 

   
Question Prompt: How does typology affect the look and 
feel of your project? Are your font and size easily legible? 
  
Narration: “I chose a slab sans-serif font because it is more 
informal looking but still easy to read. The audience of my 
learning module is teens and young adults who will be 
working at a summer camp. In the next lesson, you will 
learn how to create shapes, and I will add a white box 
behind my font to make it more readable.” 
   
Knowledge Check: Which two tabs do you have to access 
to insert and change the font? 
 

Third Learning Point: Create custom 
navigation and shapes.  

Narration: Like selecting a background image or color, 
your decision will influence the look and feel of your 
project. 
  



Question prompt: What design choices will reflect the 
theme and content of your learning module?  Will you use 
an arrow shape? Why did you make those decisions? 
  
On-screen: (1) Insert > (2) Shape > (3) choose shape or 
arrow style  

  
Onscreen: (1) Draw shape in work area> (2) Shape format 
> (3) Shape fill > (4) choose color 

  
Narration: Now, I am going to follow the same steps to 
create a white box behind my text. 
  
On-screen: Insert > Shape > choose the shape (rectangle) > 
draw the shape in the work area> shape format > Shape 
fill > choose color 
 
On-screen: (1) Right-click on shape > (2) Send to  back 
 



  
Reflection: Now that you have the three essential 
elements of your template, do you think the elements 
work cohesively? Why did you make these choices? What 
decisions would you make if you created a template for 
your favorite restaurant? 

Lesson 2 completed by Melanie Isola 
Instructional Outline: Lesson 2 
 
Learning Strategies: Direct Instruction 
+ New American Lecture  
Learning Theory: Behaviorism 
 

 

First learning Point: Setting your 
aspect ratios 

On Screen: The participant will follow the narrated video 
that guides them through the proper steps to set their 
aspect ratio. 
Design > Story Size > Choose Aspect Ratio > 16:9 
 
Narration: Welcome to your second unit on setting up a 
new eLearning template. We will be learning how to 
upload a PowerPoint template into Storyline 360 and the 
importance of properly setting up the aspect ratio prior to 
the download. (The narration and visuals will step by step 
walk the participant through this process) 
The Why: The narration ends by explaining the importance 
of setting your aspect ratio so that your PowerPoint 
template can import without any visual distortions. The 
why helps the participant invest in the importance of this 
process. PowerPoint’s default aspect ratio is 16:9, while 
Storyline’s default aspect ratio is 4:3. 
 
 



 
Knowledge Check:  
M/C Questions: Why is it so important to properly set your 
aspect ratio?  
T/F Question: What aspect ratio is the default of 
PowerPoint? 

Second Learning Point: Uploading and 
locking your template background 

On Screen: The participant will follow the narrated video 
that guides them through the steps to upload their 
template. 
Slides > Import > New Scene 
 
Narration: Now that your aspect ratio is set you are ready 
to import the template you created in PowerPoint. (The 
narration and visuals will step by step walk the participant 
through this process) 
 
On Screen: The participant will then watch as the narrated 
video shows them how to lock their template background 
into place. 
Right Click Image > Click the Lock Button on the Timeline 
 
Narration: If you utilized an image as your background in 
PowerPoint instead of a given template, you may need to 
lock your background image in place to ensure it does not 
move around during your design process.  (The narration 
and visuals will step by step walk the participant through 
this process)  
The Why: The narration ends by explaining why it can be 
helpful to lock your background images and how decisions 
you make in a slide will affect any future duplicate slides.  
 
Knowledge Check:  
M/C Question: How do you properly lock your background 
in place?  
T/F Question: Why is this an important step? 

Third Learning Point: Turning off the 
default navigation provided from 
Storyline 360 

On Screen: The participant will follow the narrated video 
that guides them through the steps to turn off their 
default navigation provided.  
Player > Menus&Controls > Off →  
Triggers > Click Previous + Next Triggers > Delete 
 
 
 



 
 
*Image shows the final stage where the participant would delete the provided triggers.  

 
 
Narration: Since you have worked so hard to create your 
own navigation buttons, we want to turn off the default 
options provided to us by Storyline 360. (The narration 
and visuals will step by step walk the participant through 
this process) 
The Why: The narration ends by explaining it can be 
distracting during the development stage to see 
unnecessary triggers on each slide. It is better to delete 
these to have a cleaner look.  
 
On Screen: The participant will follow as the narrated 
video takes them through the basic triggers of forward and 
backward navigation.  
Triggers > Paper Icon (insert) > Jump to slide: Next > When 
the user clicks: Image > OK 
 
*Image shows the process of adding in a next slide trigger.  

 
Narration: Now that you have removed the unnecessary 
default triggers, you can add in your own backward and 
forward navigation. (The narration and visuals will step by 
step walk the participant through this process) 



The Why: The narration ends by explaining that you 
wouldn’t want to have competing navigation options as it 
can cause cognitive overload in your learners. 
Knowledge Check:  
M/C Question: How do you properly turn off the default 
navigation? 
 
Knowledge Check Lesson 2:  
Drag/Drop Question: What is the proper order of 
operations to do the following steps.  
Set your aspect ratio, Import your PowerPoint, Lock your 
backgrounds, Remove the default navigation, Set basic 
forward and backward navigation on your provided 
buttons.  

Completed as an Instructional Design Team to bring a cohesive voice to these units.  
Review + Guided Practice:  Lesson 1 teaches participants how to complete three 

actions in Powerpoint. It also includes self-expressive 
learning through decision-making prompts, encouraging 
participants to consider why they are choosing colors and 
fonts. 
 
Lesson 2 is all about muscle memory and committing new, 
important material to the participant’s long term memory. 
The focus is on behavioral adaptations.  
There will be knowledge questions after each learning 
point. These will ensure the participant is engaged in the 
microlesson.  
 
A short review video on both lessons: 
 
   Narration: In lesson 1, we learned how to set up a 
    template in PowerPoint by selecting a background  
    image, deciding on fonts and sizes, and creating 
    navigation buttons. Remember that your design choices  
    should reflect the learning material and still be legible.  
 
    On-screen: Fast forward video going through processes 
    for the three steps.  
 
    Narration: In lesson 2, we learned how to import this 
    template into Storyline and ensure our project is  
    properly set with the right aspect ratio, locked  
    background and custom navigation.  



 
    On-screen: There is a video reminding the participants 
    of these three steps that they just learned.  
 
Practice:  
Participants are encouraged to test out their knowledge of 
Powerpoint and Storyline with a sample project. Learners 
can download files to use or find their own images. If 
participants run into trouble, quick access to reach section 
of lesson 1 and 2 will be linked for easy access.  

Evaluation:  Multiple choice questions: Identifying the tools used in 
setting the background, choosing and changing fonts, and 
inserting shapes in PowerPoint.  
 
Drag and Drop: The learner is then asked to properly drag 
and drop the correct order of procedures from aspect 
ratio, to import, to locking the background and then finally 
to modifying the navigation in Storyline.  
 
Scenario: Participants are given a scenario for a learning 
object they will be creating.  
1)They are given several images to choose from. 
Participants must choose the image that correctly fits the 
theme and adjust transparency if needed.  
2) Learner will then choose from 3 font families for the 
text. They must keep in mind legibility.  
3) Participants are provided with shapes of different 
colors; they must choose the shape and color that most 
closely relates to the theme.  
 
After each step, the learner is asked either a multiple 
choice question or true/false question.  

Retention and Transfer:  Following the completion of both lesson 1 and lesson 2, 
the participant will be required to create and upload three 
slides from PowerPoint into Storyline 360 
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